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Autodes Navisworks – 4D simulatsiooni loomine 
 
Ülesande püstitus 
Antud juhendis vaatame Autodesk Navisworks näitel, mis on 4D simulatsiooni loomise põhisammud. 
Selleks on meil kasutada Autodesk Revit fail (ning ka EHRi andmed, vt eraldi juhendit), kuid 
lähtematerjalina võib selleks olla ka teised Navisworks tarkvara poolt toetatud vormingud. 

 

4D simulatsiooni loomise protsess 
1. Käivita Autodesk Navisworks tarkvara 
2. Vali Append ning lisa Autodesk Revit projekt kui *.rvt failina (eelkontrollitud, tegelik 

koordinaat lisatud) 

Märkus. Antud näites töötame ühe Revit mudeliga, kuid neid võib olla mitmeid (erinevad 
osamudelid). Lisaks võib olla kaasatud ka teisi faile (avatud formaadid, DWG jne).  

  

Märkus. Navisworks loob lingitavast failist n-ö cache faili, mis paikneb samas asukohas, kus ka 
originaalfail ning omab faili laiendit *.nwc. Seeläbi saab projekti hiljem kiiremini avada. Kui see 
kustutada, tuleb see uuesti luua. Seega peaks projektiga kaasama ka *.nwc failid (kui see edastatakse 
just *.nwf failina). Tasub aga tähele panna, et kui Navisworks projekti kausta teistega jagada, siis 
võidakse küsida, et millisest asukohast on lingitud failid leitavad, kuna need ei ole üldjuhul salvestatud 
samasse kataloogi kui me teise osalisega neid jagame! Näidates uue asukoha ja salvestades uuesti 
*.nwf faili, ei pea me järgmisel korral enam neid asukohti uuesti näitama.  

Märkus. Olukorras, kus lähtefaili on vaja muuta ja see uuesti laadida, siis tuleb originaalfail üle 
kopeerida (meie näites siis *.rvt fail) ning Navisworks tarkvaras valida Home > Project > Referesh. 

3. Sinu Selection Tree palett peaks seejärel nägema välja alljärgnev. Kliki + märgil, et avada faili 
alamstruktuur. 
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Märkus. Sa võid soovida vaateakna tausta ära vahetada. Liigu riba paanile View > Scene View > 
Background ning avanevas dialoogis vali Mode = Horizon.  

 

4. Pane tähele, et projekt on liigendatud korrusteks ja seejärel omakorda komponentide 
kategooriad. Seejärel kuvatakse üksikud kihid/komponendid. 

Märkus. See on üks olulisemaid lähtepunkte, et meil oleks kasutada failide struktuur ja 
alamkomponentideks liigitus, mis ulatuses soovime neid kaasata 4D simulatsiooni.  

5. Sa saad osasid veel avada, + märgist. Kui klikid üksikul real, siis valitakse see objekt/objektid 
ka joonisel. Näiteks Toposolid 1 (ehk antud juhul maapind). 

 

6. Järgneval keskendume lihtsa 4D simulatsiooni koostamise põhisammudele. Ava riba pealt 
Home > Tools > TimeLiner 
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7. Kuvatakse 4D simulatsiooni loomise palett, TimeLiner 

 

8. Siin paletil me loome ehitustegevuse, seome selle mudeli komponendiga ja lisame selle 
ehitustegevuse ajalise kestvuse (4D simulatsioon) ning soovi korral ka maksumuse (5D 
simulatsioon). Siinses näites piirdume 4D simulatsiooniga. 

9. Kliki nupul Add Task. Luuakse uus rida allolevasse tabelisse. 

 

10. Lähtuvalt valitud projektist, nimeta ka ehitustegevuse üldine nimetus sellele vastavalt (lihtsalt 
vali rida, mille Name väärtust soovid muuta, tee veel üks aeglane vasak klikk, et saaksid 
nimetuse ära muuta). Vajutades ENTER, luuakse automaatselt uus rida.  

 

11. Vastavalt 4D simulatsiooni detailsuse soovile, igat konkreetset tegevust (ehitusplatsil) 
iseloomustab üks tegevusrida (Add Task). Tegevuseks võib olla nii ehitamine, lammutamine 
kui ka näiteks mõne ajutise konstruktsiooni tekitamine (abikonstruktsioon, tellingud jne) või 
näiteks ehitusplatsi logistika. 

12. Loodud tegevusi saad üksteise suhtes ümber reastada näiteks Move Up ja Move Down 
nupuga. 
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13. Tegevuste koondamiseks peagrupi alla kasuta valikut Indent.  

 

14. Seejärel on meil Olemasolev grupi all koondatud tegevused, mida saame lahti/kinni lükata. 

  

15. Loome peagrupid vastavalt korruse tasapindadele (see sõltub korruste arvust). Hetkel ei lisa 
00 Maapind gruppi, kuna selle me kaasame n-ö algseisu (Olemasolev), kuna seal vaid 
maapinna komponent ongi. 

 

16. Selleks, veidi paremat aimu saada, mismoodi võiks alamtegevused põhigruppide alla jagada, 
peidame 02 Katus, 01 Korrus (ja ka kõrgemad korrused, nt 02 Korrus jne). Peitmiseks võid 
teha parema kliki vastava rea peal ning vali Hide. 

 

Märkus. Peitmise tase (ja sealt omakorda üksiku komponendi kuvamine, nii et muu jääb endiselt 
peitu) sõltub parema kliki poolt määratavast valikust Set Selection Resolution … 
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Seega olukorras, kus oled terve korruse peitnud ja valikuga … To Last Object, ei saa sa kuvada selle all 
olevat alamkomponenti. Mistõttu teatud olukordades on mõistlik peita elemendi kategooriaid ja mitte 
tervet korrust.  

 

Märkus. Pane tähele, et mudeli vaates see osa peidetakse. Samas on meil ka mahumudel, mille 
peidame läbi <No Level> valiku. Mõistagi saame peita ka üksikut komponenti täpselt samamoodi 
(olukorras, kus mõni komponent on oluline, teine mitte).  

17. Pane tähele, et hetkel taldmikuplokk kuulub -01 Sokkel alla, samas kui vundament 01 Korrus 
alla (sest see on modelleeritud 01 Korruse tasapinnast allapoole). Sellised järjestused 
(vaikimisi grupid) on väga tihti erinevad sellest, kuidas hoonet ehitatakse. Seega tuleb meil 
teatud komponente -01 Sokkel osas valida ka teiselt tasapinnalt. Mõned simulatsiooni 
tarkvarad võimaldavad teha lihtsaid reegleid, kus siis teatud komponentide vahel on seosed 
ja need lingitakse automaatselt õigele n-ö ehitava korrusetasapinnaga (mudeli 
korrusetasapinnad ja seotud objektid > ehitatava korrusetasapinnaga + objektid).   
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18. Siinkohal simuleerime ehitamist alt üles ja viisil, kus siis kõik nõutud ehituskomponendid 
muutuvad nähtavaks (teatud ajahetkel). Mudeli komponentide sidumiseks tegevusega 
TimeLiner vaates on meil mitmeid võimalusi (nt läbi Selection Set, Find funktsionaalsuse, kus 
otsime teatud komponente nt klassifikaatori järgi – sest ka selle baasil saame ehitise 
defineerida ajalises mõõtmes). Võimalus oleks kasutada ka Revit Phases funktsionaalsust, 
kuid üldjuhul Revit mudelis me ei lähe nende Phases defineerimisega nii detailseks kui seda 
hetkel 4D simulatsiooniga teeme (tüüpiliselt kasutame Revit Phases olukorras, kus soovime 
näidata näiteks renoveerimist/remonti/ruumiplaneeringu muutmist ja/või selle järjekorda. 

19. Tekitame esmalt 2 lisategevust -01 Sokkel alla 

 

20. Valime Taldmik (Fibo) rea (mis kaasab kõiki alamkomponente), hoiame all vasakut hiire 
nuppu, tirime selle TimeLiner > Taldmik rea peale ja laseme hiire nupu lahti. 
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21. Pane tähele, et sellega täitub veert Attached, mis lihtsalt ütleb, et teostatud on kindel 
objektide valik ja seotud tegevusega.  

 

22. Sarnaselt, leia vundamendi seinad (siin näites 01 Korrus > Walls > Basic Wall > Kivivundament 
…) ning tiri need TimeLiner > Vundament tegevusreale. 
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Märkus. Elemendid ei pea olema nähtavad (Selection Tree paletil), et me saaksime neid tirida. Meil 
on aga hetkel lihtsam järgida, mis on tegevusega seotud ja mis mitte. 

23. Liigume nüüd tegevusgrupile 01 Korrus ja lähtume, et esimese korruse põrand kuulub juba 
sellele grupile. Loo alamtegevus ning lisa põrand vastavale tegevusele.  

 

24. Seejärel eeldame, et esimese korruse välisseinad tehakse ühe tegevusena (kusjuures ka 
soojustus, viimistlus – kui soovida neid eraldi tegevustena, mis oleks ju loogiline, siis peaks 
need komponendid olema ka eraldi valitavad – nt Revit mudelis Create Parts loogika) 

Märkus. Siinkohal võib tuua näite, kuidas klassifikaatori järgi on filtreeritav esimese korruse 
välisseinad, mida meie mudelis iseloomustab omadus AC157_SysteemID = B1001 (samas kui teise 
korruse omad on B1011). 

25. Näite demonstreerimiseks kuvan esmalt kõik seinad (1K, 2K) 
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26. Riba paanilt Home > Select & Search > Find Items 

 

27. Vasakul pool saan piirata, mis mahus otsingut teostan (nt saan valida, et ainult omaduste 
seast) 

 

28. Jätame vaikimisi valikule, seejärel paremas sektsioonis defineerime järgmise rea: 

 

29. Nüüd selle otsingu probleem on, et hetkel meie CCI RDS kaasab ka akende juures seda sama 
omadust, aga meie tahame valida vaid seinasid. Seina osasüsteemi määramine siin ei aita, 
kuna ka need on akende juures märgitud. Küll aga ei ole seinte juures märgitud komponendi 
väärtust. Lisame järgmise rea: Custom > AC175 … > Undefined 
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Märkus. Paneme tähele, et nn teise korruse seinte otsi ei võeta valikusse, kuna neil teine süsteemi ID. 
Kuid samas ei ole valitud osasid välisseinasid, mis justkui peaks olema valitud. Siinkohal on ilmselt 
probleemi allikas Revit faili impordil ja see tundub olevat Navisworks probleem (vt 
https://www.autodesk.com/support/technical/article/caas/sfdcarticles/sfdcarticles/Revit-model-
element-properties-are-missing-in-Navisworks-2018.html ). Juhendis märgitud nõuanded ei ole 
hetkeseisus seda probleemi lahendanud, mistõttu teostame käsitsi lisamise. Algallikaks on asjaolu, et 
valimate seinte juures ei ole mingil põhjusel kaasatud kasutaja omadusi (Custom paan on Properties 
paletil puudu). 

  

30. Kuna hetkel soovime omadustel baseeruvat filtreerimist salvestada ka edaspidiseks (nt mõnes 
teises mudelis kasutamiseks), saame klikkida töövahendil: Manage Sets 

https://www.autodesk.com/support/technical/article/caas/sfdcarticles/sfdcarticles/Revit-model-element-properties-are-missing-in-Navisworks-2018.html
https://www.autodesk.com/support/technical/article/caas/sfdcarticles/sfdcarticles/Revit-model-element-properties-are-missing-in-Navisworks-2018.html
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31. Olles Find Items dialoogis klikkinud Find All, saame selle nüüd salvestada Save Selection 

 

32. Anname nimetuse CCI 1K välisseinad 

 

Märkus. Neid filtreid saab salvestada Sets dialoogi parempoolse nupu kaudu, Export Search Sets… 
Seejärel, mõnes teises mudelis omakorda, Import Search Sets… 

 

Läbi nende töövahendite, Find Items, Sets – on sul võimalik luua väga n-ö intelligentseid 
valikukriteeriumeid, samas kui mudel on vigane, siis on paratamatu, et tuleb kontrollida ja vajadusel 
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otsingut parandada. Järgides teatud reegleid, saab seeläbi tekitada ka automaatsed ehitustegevused, 
mis lingivad kindlad komponendid.  

33. Sulge Find Items dialoog, endiselt on välisseinad valitud, hoia CTRL klahvi all ning vali näiteks 
puuduolevad (kui neid peaks olema) elemendid mudeli vaatest või Selection Tree vaatest. 
Vajadusel pööra mudelit erinevate nurkade alla, et veenduda õiges valikugrupis. Seejärel 
lohista need TimeLiner > 1K välisseinad peale.   

 

34. Järgmise tegevusena valime siseseinad ja seome need ühe grupina kui 1K siseseinad (isegi siis 
kui need tegelikult võidakse ehitada peale katuslae lisamist, meie näites ei ole neist ükski n-ö 
kandev). Võime teha otsingu CCI süsteemikoodiga B20 ning veenduda, et seeläbi ei võeta teisi 
komponente (sarnaselt eelmisele näitele). Vajadusel täiendame valikut.  
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35. Jätkame tasandil 02 Katus, ja lisame selle alla nii Katuslagi, 2K välisseinad ning Katus. Seome 
vastavad komponendid antud tegevustega.  

 

36. Seejärel täiendame juba lisakomponentidega aga seda enam mitte korruse tasandi piires. 
Loome tegevuse Uksed-aknad ning seome need ühe tegevusena (kõikidelt korrustelt). 
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Märkus. Sa pead korraga need valima ning tirida Uksed-aknad peale. Kui näiteks tirid esmalt aknad ja 
siis uksed, siis viimased asendavad esimesi. Soovide lisada eelnevale valikule võid kasutada valikut 
Append Current Selection. 

 

37. Veendu, et kõik põhilised arhitektuursed (konstruktsiooni) elemendid oleksid kaasatud 
simulatsiooni. Kuna on olnud soovitus, et järk-järgult tood elemente peidust välja (Selection 
Tree valikus), siis on selle baasil ka hea näha, mis on seotud, ja mis pole. 

38. Sul on võimalus minna ka peatasandile ning parema kliki vahendusel valida Find > Attached 
Items 

  

39. Lisa seejärel tegevus Sisustus, selle alla Santehnika ning Muu mööbel - kaasa vastavad 
elemendid enda projektist. Need võivad kuuluda erinevate kategooriate alla, mistõttu neid 
oleks lihtne klassifikaatoriga otsida, kuid hetkel ei ole neile seda lisatud. Näiteks Selection Tree 
osas vaata sektsioone Electrical Equipment, Furniture, Generic Models, Plumbing Fixtures 
jmt.   
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Märkus. See sõltub ka asjaolust, millist perekonna malli on kasutatud, et see komponent luua. 

40. Korrigeerime nüüd Olemasolev sektsiooni ning lisame alamtegevuse Maapind ning seome 
oma hetke maapinna mudeli just selle tegevusega.  

 

41. Tegevuste lõppu lisame ka kategooria Väliala ning selle alla Terrass-sillutis. 
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42. Sellega peaksid kõik mudeli komponendid olema seotud tegevustega (välja arvatud 
ruumobjektid, mida me ei seo) 

43. Varasemalt on saanud märkida, et tegevused võivad olla ehitatavad, lammutatavad või ka 
olemasolevad (ja jäävadki alles või sellest me lähtume). Seda määrame TimeLiner veerus Task 
Type. Lisamegi kõikidele ridadele, kus on liidetud objekte/komponente (seda näitab ka veerg 
Attached) valiku Construct (välja arvatud Maapind, millega tegeleme hetke pärast). 

 

44. Liigume TimeLiner paanile Configure ning lisa uus Task Type, nimeta see kui Olemasolev, 
seadista parameetrid alloleva pildi kohaselt, ehk siis kasutame läbivalt mudeli enda 
värvitoone. 

  

45. Tagasi Tasks paanile ning veendu, et Maapind osas oleks Task Type = Olemasolev 
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46. Järgnevalt lisame Planned Start ning Planned End ehk ajalise mõõte igale tegevusele, mis 
kaasab komponente. Lähtume lihtsast põhimõttest (selles näites), et iga tegevus kestab 
täpselt 1 nädal (esmaspäevast – pühapäevani). Ajavahemikku ei lisa Maapind reale, kuna see 
on meil kohe alguses olemas! 

Märkus. Ajagraafikut on võimalik koostada ka olemasoleva baasil (nt Microsoft Project). Mitmed 
tegevused võivad olla üksteisega seotud, et enne ei saa järgmisega alustada kui eelmine pole täidetud. 
Tüüpiline Gantti diagrammi näide. Või siis teatud tegevusi saab paralleelselt teha (ehitusgraafiku 
optimeerimine). Neid asju saab ka Navisworks TimeLiner sektsioonis arvesse võtta. Hetkel siiski teeme 
lihtsa 4D simulatsiooni. 

 

Märkus. Pane tähele, et alamkategooria kuupäevad näitavad summeeritud vahemikku vastavalt 
alamtegevustele. Peatasand (AA-Eramu) jällegi kogu projekti kestvust.  

47. Liigu nüüd paanile Simulate 

 

48. Käivita 4D simulatsioon, klikkides Play nupul 

 

49. Hoone ehitust hakatakse simuleerima. Simulatsiooni käigus võid vabalt mudelis ringi liikuda 
(navigeerida, suurendada/vähendada). 
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Märkus: Komponentidele on võimalik peale panna realistlikud materjalid, et visualiseerimise aspektist 
see suuremat efekti omaks. Samuti on võimalik muuta värvitoone, mismoodi kuvatakse need objektid, 
mis on ehitusetapis (nt siin näites rohelise tooniga). 

Märkus: Simulatsiooni on võimalik salvestada videofailina, et seda edastada erinevatele osalistele. 
Lisaks saab Autodesk Navisworks faili jagada nn Autodesk Navisworks Viewer paketi vahendusel. 

50. Salvesta projekt. 
51. Salvesta projekt ka teises formaadis. Selleks, kliki N > Save As. 

 

52. Avanevas dialoogis veendu, et nüüd valid faili tüübi *.nwd. Kliki Save. 

Märkus: NWF fail sisaldab linke algfailidele (nt meie näites AutoCAD *.dwg failile), mistõttu selle 
edastamine ilma *.dwg failita on kasutu. Seevastu NWD faili integreeritakse kõik lingitud failid sisse. 
Mõlemal on omad eelised. Üldjuhul me töötame NWF failis ja kui on vaja teha mingeid vaheseise, 
mida enam algtasandil redigeerida ei saa (faile välja vahetada näiteks), siis teeme NWD.  
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